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PRECON – Preconstruction 

Setting Up Your Browser 

Because web-based AASHTOWare Project is a web application, correct browser settings are an important part 

of making sure the application performs as it should. The information in this topic will help you to set your web 

browser options correctly. 

Using the Correct Browser 

Web-based AASHTOWare Project is designed to run on Google Chrome or Internet Explorer, versions 10 and 

11. If you are using Internet Explorer, make sure you update your browser to one of these versions. 

Setting the Browser Mode in Internet Explorer 

If you are using Internet Explorer, the browser mode should be set to its native mode at all times, not to a 

previous version view or a compatibility view. When you initially log on to AASHTOWare Project using 

Internet Explorer, the browser mode is automatically set to Compatibility View. 

Follow these steps to change this default setting: 

1. Open the Internet Explorer browser. 

2. Press the Alt key to display the toolbar. 

3. From the Tools menu, select Compatibility View Settings. 
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4.  
 

The browser opens a Compatibility View Settings dialog window. 

5. In the Compatibility View Settings window, clear the Display intranet sites in Compatibility View 

check box. 

6. Click Close. 

Setting Internet Options in Internet Explorer 

For components to be displayed properly in Internet Explorer, the browser must be set to refresh previously 

viewed pages, and the browser security must enable DOM storage. Follow these steps to verify these settings: 

1. Open the Internet Explorer browser. 

2. From the Tools menu, select Internet Options. 

 

The browser displays the Internet Options dialog box. 
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3.  
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4. Under Browsing History, click the Settings button. 

 

The browser displays the Temporary Internet Files and History Settings dialog box. 

5. For the Check for newer versions of stored pages setting, click the Every time I visit the webpage 

option. 

6. Click OK. 

7. In the Internet Options dialog box, click the Advanced tab. 

8. In the Settings box, scroll down to the Security section, and ensure the Enable DOM Storage option is 

selected. 

9. Click OK. 

10. Note: If the AASHTOWare Project website is hosted on a server outside of the agency’s local intranet, 

ensure that the Internet Explorer option for Font Download is set to Enable for the Internet security 

zone. If enabling font downloads is not desirable or prohibited by group policy settings for the domain, 

add the AASHTOWare Project website to the list of Trusted Sites. This enables the system to properly 

display icons. 

 
  

wmills
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5. For the Check for newer versions of stored pages setting, click the Every time I visit the webpage 
option. 
6. Click OK. 
7. In the Internet Options dialog box, click the Advanced tab. 
8. In the Settings box, scroll down to the Security section, and ensure the Enable DOM Storage option is 
selected. 
9. Click OK. 
10. Note: If the AASHTOWare Project website is hosted on a server outside of the agency’s local intranet, 
ensure that the Internet Explorer option for Font Download is set to Enable for the Internet security 
zone. If enabling font downloads is not desirable or prohibited by group policy settings for the domain, 
add the AASHTOWare Project website to the list of Trusted Sites. This enables the system t
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Navigating in Web-Based AASHTOWare Project 

The Dashboard 

When you log on to the system, the software opens on the dashboard. You can also go to the dashboard at any 

time by clicking the Home button on the Menu Bar. 

The dashboard contains one or more components. Each component is identified by a title set within a blue 

header bar. Each component provides access to the information and processes required for a specific area of 

your agency's work. The components you see on your dashboard are those that match the specific areas of 

responsibility assigned to your active role. See Understanding Your Role and Using Components for more 

information. 

The following example shows the dashboard as it might appear for a system administrator. Keep in mind that 

some of the components shown in the example might not be available for you depending on your active role and 

which business areas are included on your system. 
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The dashboard includes these standard features: 

• Menu Bar — The system displays the Menu Bar at the top of every webpage in the system. The buttons 

and menus on this bar help you to move quickly through the system to visit the pages and components 

you use most often. 

Your agency may choose to also display these features on your dashboard: 

• Home Page News — This component provides important information from your agency. 

• External Links — This component provides links to websites you use outside of the AASHTOWare 

Project application. 

 

 

Menu Bar 

The Menu Bar is a horizontal strip at the top of every application webpage.  

The left side of the Menu Bar contains these buttons and menus: 

• Home - This button is a link to the dashboard for your active role. Clicking the down arrow opens the 

Home menu, which contains an indicator for your active role (bold text with a green check mark) and 

lists all the roles assigned to you. This menu allows you to switch roles from any location in the system. 

When you switch roles, you remain in the component in which you were working unless the new role 

does not have appropriate security rights, in which case the system takes you to the dashboard 

• Recent - This button is a link to the Recent Activity Overview component, where you can manage a list 

of the most recent pages you have visited in your active role. Clicking the down arrow also displays the 

list, sorted by most to least recently visited. If you click on a page in the list, the system takes you to that 

location. 

• My Pages - This button is a link to the My Page Overview component, where you can manage 

frequently used (or favorite) pages for your active role. You can add pages as favorites from any 

location in the system by clicking the down arrow and selecting Remember this Page. 

The right side of the Menu Bar contains these buttons and menus: 

• Actions - Clicking this button opens a menu of actions you can take within the system. The actions that 

are listed are limited to those that are relevant for your active role. When you select an action, the 

system automatically takes you to the component in the system where the action can be performed. 
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• Help - If your agency has recorded agency Help, clicking this button takes you to a separate browser 

window containing online help for your active role. If agency Help has not been recorded, clicking this 

button takes you to the Welcome page of the standard online Help. 

• Log off - Clicking this button ends your session. 

Quick Links 

Quick links are displayed in blue text below the Menu Bar and above the webpage title. These links allow you 

to quickly jump to application pages related to the current page. 

 

If you are on a page that contains multiple components, quick links preceded by the label On this page are 

displayed for each component on the page. When you click one of these quick links, the system automatically 

scrolls the page to the location of the component. 

Hypertext Links 

Hypertext links can be located anywhere on an application component or webpage and are identified by blue 

text. When clicked, a link takes you to another component or page, usually one containing more detailed 

information than what is available in the current component. After you have clicked a link, it changes from blue 

to purple to remind you that you have already visited that link. 

Icons 

Icons are small images throughout the system that either convey information or can be clicked to perform an 

action. For example, a red asterisk icon indicates a required field. An eraser icon in a Quick Find search box can 

be clicked to reset search criteria. This table shows some of the common icons used in the system: 

  

Icon Usage 

 

The eraser icon appears in Quick Find search boxes after criteria is 

entered. You can click the icon to reset the search criteria 

 

This magnifying glass icon at the left side of a field indicates an 

auto-complete field. Auto-complete fields display a filtered list of 

field values based on the first few characters you type. You can 

press Enter to show all values. 

 

This magnifying glass is sometimes displayed on the right side of a 

text box. Clicking this button opens a text dialog panel that allows 

you to view and edit the text in a larger area. 

 

A red asterisk indicates a field where data entry is required. 
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The actions icon appears on Actions buttons that you can click to 

display an Actions menu. Actions menus provide access to 

commands and functions you can perform on data. 

 

The red X icon appears on Delete buttons that you can click to 

remove newly added rows that have not been saved. Clicking a 

Delete button removes the row immediately. 

 

The trash can icon appears on the Mark for Deletion button that 

you can click to remove saved rows. When you click the Mark for 

Deletion button, the button changes to an Undo button. The row is 

removed only when you save the changes. 

 

The undo icon appears on Undo buttons that you can click to 

reverse an action, such as deleting a saved row. 

 

The help icon appears on Help buttons that you can click to display 

the online Help system. 

 

The calendar icon is displayed on the right side of a date field. You 

can click the calendar icon to display a calendar where you can pick 

a date as the field value. 

Alternate Paths 

Keep in mind that all of the various navigational elements, such as hypertext links, quick links, recent pages, 

and Actions menus, can all provide different ways of accomplishing the same task. The same command might 

be accessible from an Actions menu or as a link. For example, to access the Project Overview component, you 

can click the Projects link on the Preconstruction component, or you can select Open from the Actions menu 

on the Projects row. Both methods of navigation achieve the same result. Feel free to explore the system and 

find the ways of navigation that are best for you. 

Using Bookmarks 

You can bookmark specific pages in the software just as you would for any other website. However, if you have 

not yet logged on to the system, clicking a bookmark will take you to the logon page rather than the 

bookmarked page. 
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Accessing the Help File 

For more information on Navigating in AASHTOWARE Project software, click the Global Help icon in the top 
right next to the Logoff button. 

                                        
Expand the Getting Started section 
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Entering a Project into Precon 

1. Click on Projects under the Preconstruction section to return to the Project Overview component.  
2. From the Project Overview component type at least the first 3 characters of your project key number, select your 

project 

 

Modify the Project 

3. * indicates a field is required by the system. ITD requires additional information as noted below. 
4. Click on the General tab 

Fill in the missing information  
Project ID- key number imported from Estimator 
Project Description - project description imported from Estimator should match OTIS (Proj. Name) 
Spec Book = Last 2 digits from spec book, transitioned over from Estimation 
Unit System = English 
Federal Project Number - project number imported from Estimator 
Controlling Project – check this box if the project is the lead key  

Criteria for determining Lead Key: 
Full Oversight projects are lead over Exempt projects 
Project on FHWA Project of Interest 
Largest Eng. Estimate (both Federal funded) 
Federal Aid if companioned w/State 
Largest Engineer’s Estimate (both State funded) 

Project Type - select Federal or State  
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Status - Select 3 - Estimated 
Project Work Type - (select from menu to match project data) 
Project Item Total – calculated 
Work Authority # - work authority number (Ex. E134410) This number is used by the SiteManager/AMS interface 
Urban/Rural Class - Select type of Terrain (Refer to Type of Terrain in Appendix A) 
E & C Percent – Engineering CA 10% (CE + CC), and CC 5%. For a total of 15%! 
Primary Project County ID – entered on Counties tab  
Primary Project District ID – entered on Districts tab  
Estimate Date - enter the date prepared (Ex. 03/06/2014) or select from calendar icon 
Revised by - N/A, leave Blank 
Designer - select District group (Ex. D2RD) 
Click - Save 

5. Click on the Counties tab, verify all the project’s counties by percentage are listed and total to 100% 
6. Click on the Districts tab, add the code for the Construction Residency from the menu, see Appendix A 
7. Click on the Points tab, change the Latitude and Longitude for the midpoint of your project, include Description 

a. Change “Midpoint” to Project Name in OTIS 
NOTE: Must be in DDMMSS format. Double check this as it defaults to Stanley, Idaho 
8. Click on the Road Segments tab and click New 

Name - Project Description should match OTIS 
Number - (refer to the segment code from OTIS) 
Description – (Public Description in OTIS) 
Type - select type of road 
Route - Name of the Roadway (Ex. US-95, SH-55, or STC-3809) 
Lane Mile – (if applies) 
Length – Length of project (if applies) 
Width – Width of roadway (if applies) 
Depth – (if applies) 
Start Latitude –  
Start Longitude -    
End Latitude –  
End Longitude -    
Begin Termini - Beginning mile point 
End Termini - Ending mile point 
Begin Station - Beginning station (if applies) 
End Station - Ending station (if applies) 
Category ID – select category 
Click Save  

9. Click on the Bridge Segments tab 
Bridge ID - Leave blank unless bridge items apply 
Description -  
Bridge Type - Leave blank unless bridge items apply 
Length - Leave blank unless bridge items apply  
Width - Leave blank unless bridge items apply 
Number of Spans - Leave blank unless bridge items apply  
Start Latitude – N/A 
Start Longitude -   N/A 
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End Latitude – N/A 
End Longitude - N/A  
Category ID – select categories for Bridge work 
Click Save 

10. Click on the Workflow tab 
Workflow – select Default Workflow 
Workflow Phase – select Project Definition 
Click Save 

Modify the Project Categories and Items 

11. Click on the Categories and Items menu to review and verify items. 
12. Click on the General tab (information from the Project General tab) 
13. Click on the Categories tab 

Category ID - the ITD Standard is that the first Category is 0001 increment by 1. (ex. 0001 = Roadway, 0002 = Bridge, 
0003 = Non-Bid Items) 
Combine with Like Categories – Click on box for Yes  
Bid Section Group – Enter 0001 as a default. There will always only be one bid section group and must match the Bid 
Section Group number of the Proposal exactly (1 is not the same as 0001) 
E & C Percent – enter % for contingency and CE (may be different for each category) Use the contingency amount 
from Estimator 
Low Cost Flag – Yes (system generated) 
Unit Number - N/A, leave blank  
Unit Description - N/A, leave blank 
Category Description - Imported from Estimator 
Category Work Class - Select class This code is used by the SiteManager/AMS interface 
Category Alternate Set ID – N/A, leave blank 
Category Alternate Member ID – N/A 
Life Cycle Cost – N/A 
Click Save 

14. Click on the Category Alternate Sets tab - N/A 
15. Click on the Item Alternate Sets tab - N/A 
16. Click on the Items tab 

Click on the arrow next to the line item number to display the item details 
Cross check Item ID, Unit of Measure, Quantity and Extended Amount  
Click on the arrow again to summarize the item details 
Look for duplicate item numbers – check supplemental descriptions and price differences 
 
Please read the below for common item configurations: 
If you have companioned projects, all identical Lump Sum items should be split so the combined total of all the 
projects adds up to 1 Lump Sum andthe price for each of the lump sum items should match the total amount.   For 
Example,the $$ amount for each partial lump sum is the total $$ amount of all projects. (Ex. Project A MOB = 
$40,000, Project B Mob = $60,000.  For the example, you must configure the lump sum items to be the following: 
Project A = 0.40 quantity and  $100,000 unit price and Project B = 0 .60 quantity and $100,000 unit price.) 
For contingency items set the unit price to $1 and the quantity to the amount estimated. 
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Set the bid requirement to ‘fixed.’  This will cause the CA amount to show on the bid schedule. 
For non-bid items select the Non-Bid check box.  These non-bid items should be in their own category with 0% E&C 
 

Repeat for all Categories if more than one Category 
Click Save 

 
Setup Funding (May of already been done in Estimation) 

17. Click on the Funding Package Overview menu 
18. Click New to create a new Fund Package or choose Select Fund Packages.. Click on “Show first 10” to select from 

list 
Funding Package - select code 

000 = State/Non-Participating 
001 = Federal 
002 = Local 
003 = Other – Special Funding  

Description - Once Funding Code is selected, this field will update automatically. 
 
Please ensure that the codes are correct as these affect the task code of the AMS Financial Interface. 

 
19. After adding your Fund Package, you will need to supply the funds. Click on the 0 in the funds column. 

 
20. In the Funds in Packages section, Click Select Funds… 
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21. Click Show first 10 

 
22. Choose the correct Fund and click Add to Fund Package 
23. Enter a Priority of 1. 

  
24. Click Save. 
25. Click on the Funding: Assign to Items menu  Only one fund per group/category, this is used by the 

SiteManager/AMS interface 
26. Click on the arrow to Expand/Collapse Group 
27. Verify the items by category are associated with the correct Fund Package 

a. Select Fund Package (A) 
 
Click Save!!! 

Item Alternate Summary 

28. N/A 

Item Pricing 

29. N/A 
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Item Worksheet 

30. Click on the Item Worksheet menu 
You may edit the Project Item Price per item  

Create a Project Level Detail Estimate (This is optional) 

31. From the Actions menu select Generate Report 
32. Select Preliminary Project Detail Estimate 
33. Select your project 
34. Click on Execute, the reports are displayed in an internet browser window 

a. If it takes a long time, click your browsers Refresh button 
35. Check and verify Estimate matches Estimator Totals 
36. Click the browser’s File menu to Print or Save as the report.  

 

Create the Proposal Header (Click Home, then Project) 

1. From the Project General tab select the Create Proposal from the Action menu 

 
 

2. Add the date (00000YYMMDD) that the Estimate was created (Ex. 12345140306) to the key number in the Proposal 
ID field before saving the proposal (You will not be able to change this field once you Save) 

3. Skip to Step 7.  
Or to create a new proposal without a project continue to Step 4. 
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4. From the Home menu select Proposals 
5. From the Proposal Overview Actions menu select Add 

 
6. From the Add Proposal screen 

 
7. Proposal ID – Lead Key No and the date (00000YYMMDD) that the Estimate was created (Ex. 12345140306) 

Proposal Description - Description (Ex. Palouse River Br.) 
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Proposal Long Description - from PS&E Information Sheet from charter (Ex. for the work of constructing a turn bay 
on US-95, MP 163.13 to MP 163.55; New Meadows Turn Bay, known as Idaho Project No. A012(345), in Adams 
County, Key No. 12345) *PLEASE TRY TO KEEP WITHIN 256 CHARACTERS. 
Federal Project Number - Project No (Ex. ST-4110(648) 
DBEGOAL – Choose which option applies from the dropdown menu 
DBEGOAL (Pct) - Put in your % for Federal projects, you do not need any DBE Goals for 100% State funded projects. 
WBEGOAL (Pct) - N/A, Leave Blank 
Publication Date – N/A, Leave Blank 
Rejected - N/A, do not check 
Reason for Non-Processing - N/A, do not check 
Previous ID - N/A, do not check 
Contract Type - Select BID 
Proposal Type - Select Proposal Type (Ex. CNST) 
Contract Work Type - (Ex. 07) 
Type of Funding - Select Funding Type NOTE: Whichever fund has the larger percentage should be input in this field

 
Proposal Status – N/A, leave blank 
Proposal Cost – N/A, leave blank  
Complete Plan Cost – N/A, leave blank (headquarters will input) 
Plan Without Cross Section Cost – N/A, leave blank 
Per Plan Sheet Cost – N/A, leave blank 
Status Date - N/A, do not check 
Contract Qualification Class 1 – select from list (typically COMM) 
Contract Qualification Class 2 - N/A, do not check 
Contract Qualification Class 3 - N/A, do not check 
OJT Goal - N/A, do not check 
OJT Goal Units - N/A, do not check 
OJT Goal Comments - N/A, do not check 
Primary County - the County with the highest percent of work (Ex. C038) Refer to Appendix A 
Primary District - District (Ex. 28111, District 2 RES B) 

8. Click Save 
9. Click on the Projects tab  

Verify project(s) or click on Select Projects and add selected project(s) 
Choose all of the projects that will be added at once or you can repeat the process to add more companion projects 
as needed. 
Verify the correct lead project has been selected by checking the Controlling Proj box 

10. From the Proposal Summary window select the Time tab 
 
 
 
 



AASHTOWare Project 
Preconstruction User Guide 

AASHTOWare Project Estimator and PRECON 01/09/2020 kjs   PAGE 20 OF 30 

 
11. Click on New 

Time ID - Enter 00 
Time Description - Enter the proposal description (Ex. Palouse River Br.) 
Time Type - Select AD, CD, or DT (AD-5 Days a Week, CD-7 Days a Week, 
DT-Completion) 
Number of Time Units - No. of days for the Contract to be completed if AD 
or CD was input   
Time Units – select Days  
Main Proposal Time – select check box 
Completion Date - Date the Contract is to be completed if DT was input 
Start Date - Date the Contract is to start if DT was input 
Liquidated Damages Rate - Refer to the Schedule of Liquidated Damages 
chart to the right 
Liquidated Damages Unit of Time – select Days 
Road User Cost Per Time Unit – (A+B or Lane Rental contracts only) 
Maximum Time - N/A 
Minimum Time - N/A  

12. Click Save 
 

13. Click on the Workflow tab 
Workflow – select Default Workflow 
Workflow Phase – select Proposal Definition 

Sections and Items 

14. From the Proposal Summary window select the Sections and Items menu  
15. Click on the Proposal Sections  tab 
16. Click the red “X” to delete existing section (top right of sheet) 
17. Click Add New 

a. Bid Section Group: 0001 (this number must match the Bid Section Group number on the Project Categories) 
b. Description: (Ex. WORK BY CONTRACT A019(613)) 

18. Verify that you only have 1 Section. Click Save. 
19. Click on the Quick Action dropdown 

 
 
 
 
 
 
 
 
 
 

Original Contract Amount Daily 
Liquidated 

Damage 
From More 

Than 
To and 

Including 

$0  $100,000  $500  
$100,000  $500,000  $1,000  
$500,000  $1,000,000  $2,000  

$1,000,000  $2,000,000  $3,000  
$2,000,000  $4,000,000  $4,000  
$4,000,000  $6,000,000  $5,000  
$6,000,000  $8,000,000  $6,000  
$8,000,000  $10,000,000  $7,000  

$10,000,000  $15,000,000  $9,000  
$15,000,000  $20,000,000  $11,000  
$20,000,000    $12,000  
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20. Click Assign Items to Sections 

 
21. Assign Items to Sections and then Click Save. 

 
a. Click on Section and Items tab 

22. Click on Proposal Items tab (section and line numbers are generated automatically) 
23. Check and verify items against the Estimator report for single project proposals and assure like items have been 

combined in the Proposal 
24. Click on the Proposal and Project Items tab to verify your items are correct 
25. Click Save 
You can Validate Proposal from the Action menu to check for errors by clicking Proposal from the top. Go to Actions 
(next to the save button) and click Validate Proposal from the drop down 

 
 
 



AASHTOWare Project 
Preconstruction User Guide 

AASHTOWare Project Estimator and PRECON 01/09/2020 kjs   PAGE 22 OF 30 

 

Create Proposal Level Detail Estimate 

26. From the Quick Action dropdown  
a. Select Preliminary Proposal Detail Estimate 

27. Click on Execute, the reports are displayed in an internet browser window 
28. Check and verify Estimate matches Estimator Totals or combined amounts of multiple projects 

Preliminary Estimate vs. the Estimator file 
Cross check item number, unit, quantity and total 
Also look for duplicate item numbers 
If you have companioned project MOB should be split and add up to the total of 1 Lump Sum between the 
categories 

29. Click the browser’s File menu to Print or Save as the report.  
 

Running a Proposal Price Schedule/Bid Schedule Report 

After your proposal is complete, you should run a proposal price schedule (Bid Schedule) report to verify that your 
items are configured correctly. 

1. From the Proposal, Click on the “Actions” Drop Down in the blue ribbon of your proposal (shown by the 
red circle in the below image) 

 
2. Select the Proposal Price Schedule Report from the list in the drop down. 
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3. Click the “Execute” Button (you may have to double click it). You do not need to change any settings. 

 
4. When your report opens: 

▪ Double Check that the CA items are shown with a fixed bid amount 
▪ Make sure all lump sum (and other items) do not have a fixed bid amount 
▪ Double check that all items are listed. 

 
Other than CA items you should not see any prices here! 
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Release Control to HQ  

NOTE: ONLY DO THIS ONCE YOU ARE READY TO SUBMIT TO HQ 
30. Go to Proposal Summary  

Select Workflow  
Workflow – select Default Workflow 
Workflow Phase – select Manage Revisions (This can be changed back to “Project Definition” to fix any needed 
changes) 

31. Click Save 
32. An automated email will be sent to the Advertise and Award group with the Project Name and Key Number 
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Appendix A 

Type of Terrain 

Flat desert terrain is that condition where highway sight distances, as governed by both horizontal and vertical 
restrictions, are generally long or could be so without construction difficulty or major expense. 
 
Rolling terrain is that condition where the natural slopes consistently rise above and fall below the road or street grade 
and where occasional steep slopes offer some restriction to normal horizontal and vertical roadway alignment. 
 
Mountainous terrain is that condition where longitudinal and transverse changes in the elevation of the ground with 
respect to the road or street are abrupt and where benching and side hill excavation are frequently required to obtain 
acceptable horizontal and vertical alignment. 
 
Urban terrain is related to, characteristic of, or constituting a city. 
 
Irrigated terrain is an area of land supplied with water by artificial means. 
  



AASHTOWare Project 
Preconstruction User Guide 

AASHTOWare Project Estimator and PRECON 01/09/2020 kjs   PAGE 26 OF 30 

Federal Work Type Category 

 
WORK TYPE CODE DESCRIPTION 

01 New Construction 

03 Reconstruction-Added Capacity 

04 Reconstruction-No Added Capacity 

05 4R Maintenance-Resurfacing 

06 4R Maintenance-Restoration & Rehab 

07 4R Maintenance-Relocation 

08 Bridge-New Construction 

10 Bridge Replacement-Added Capacity 

11 Bridge Replacement-No Added Capacity 

13 Bridge Rehabilitation-Added Capacity 

14 Bridge Rehabilitation-No Added Capacity 

15 Preliminary Engineering 

16 Right of Way 

17 Construction Engineering 

18 Planning 

19 Research 

20 Environmental Only 

21 Safety 

22 Rail/Highway Crossing 

23 Transit 

24 Traffic Management Engineering-HOV 

25 Vehicle Weight Enforcement Program 

26 Ferry Boats 

27 Administration 

28 Facilities for Pedestrians & Bicycles 

29 Acq of Scen Esmts & Scen or Hist Sites 

30 Scenic or Historic Highway Programs 

31 Landscaping & Other Scenic Beautificatio 

32 Historic Preservation 

33 Rehab & Oper of Hist Trans Bldg/Str/Fac 

34 Preservation of Abandoned Railway Corr 

35 Control & Removal of Outdoor Advertising 

36 Archaeological Planning & Research 

37 Mit of Water Pollution Due to Hwy Runoff 

38 Safety & Education for Ped/Bicyclists 

39 Establishment of Transportation Museums 

40 Special Bridge 

41 Youth Conservation Service 

42 Training 

43 Utilities 

44 Other 

45 Debt Service 
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County Codes 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 

  

NUMBER COUNTY NAME 

C023 Gem 

C024 Gooding 

C025 Idaho 

C026 Jefferson 

C027 Jerome 

C028 Kootenai 

C029 Latah 

C030 Lemhi 

C031 Lewis 

C032 Lincoln 

C033 Madison 

C034 Minidoka 

C035 Nez Perce 

C036 Oneida 

C037 Owyhee 

C038 Payette 

C039 Power 

C040 Shoshone 

C041 Teton 

C042 Twin Falls 

C043 Valley 

C044 Washington 

NUMBER COUNTY NAME 

C001 Ada 

C002 Adams 

C003 Bannock 

C004 Bear Lake 

C005 Benewah 

C006 Bingham 

C007 Blaine 

C008 Boise 

C009 Bonner 

C010 Bonneville 

C011 Boundary 

C012 Butte 

C013 Camas 

C014 Canyon 

C015 Caribou 

C016 Cassia 

C017 Clark 

C018 Clearwater 

C019 Custer 

C020 Elmore 

C021 Franklin 

C022 Fremont 
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Resident and Maintenance Engineer Codes 

Code Residency 

13105 D1 Traffic & Materials Ben Ward 

13107 D1 Design Construction A Ryan Hawkins 

13109 D1 Design Construction B Justin Wuest 

13121 D1 Maintenance 

24105 D2 Operations Manager Bob Schumacher 

28111 D2 Design/Construction B Joe Schacher 

28121 D2 Design/Construction A Curtis Arnzen 

34101 Ada County Highway District Dale Kuperus 

38131 D3 Design Construction A Daris Bruce 

38132 D3 Design Construction B Jeff Ryan 

38133 D3 Design Construction C Shawna King 

38134 D3 Design Construction D Jayme Coonce 

38135 D3 Local Roads Services 

38136 Boise Maintenance 

33409 D4 Design Construction B Walter Burnside 

48141 D4 Design Construction A  Doug Yearsley 

48142 D4 Planning & Engineering Todd Hubbard 

48143 D4 Design Construction C Scot Stacey 

53511 D5 Design Construction C Eric Staats 

54105 D5 Maintenance 

58151 D5 Design Construction A Dan Harelson 

58152 D5 Design Construction B James Orner 

68161 D6 Design Construction A Drew Meppen 

68162 D6 Design Construction B Jesse Barrus 

78111 LHTAC Megan Kautz 

78112 LHTAC Matt Koster 

78113 LHTAC Kevin Kuther 

93310 HQ Highways Operations & Safety 

98111 HQ Design Materials Construction 

 

Alternate Bids in PRECON 

1. In Estimator build completely different and separate estimates (One for each Alternate) that include all the items for 
each alternative as well as the common Items. 

2. One Estimate, the most likely one to win, should be named using the Key Number (ex. 12345.est) 
3. The Alternative Bid will be named with the Key Number modified by changing the FIRST numeric Number to an 

alpha character (ex. A12345.est) 
 

Helpful Hints for Companion Projects in Estimator and PRECON 

1. For Proposals with more than one project develop separate estimates in Estimator under each project Key Number, 
you will combine them in PRECON 
NOTE: Remember to use a percentage for items such as LS and CA so that after they are combined in PRECON they 
add up to 1 

2. Create an Estimator file (12345.xml) for each estimate 
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3. In PRECON after you have completed each of the projects under Projects, you will need to create a single Proposal 
using one of the projects as the lead project. Select the lead project (Controlling Project) using the following criteria 

Full Oversight projects are lead over Exempt projects 
Project on FHWA Project of Interest 
Largest Eng. Estimate (both Federal funded) 
Federal Aid if companioned w/State 
Largest Engineer’s Estimate (both State funded) 

4. Assign the Project(s) to the Proposal in the Proposals>Projects tab 
 

Renumbering Project Items 

If your agency has the Automatically Renumber Project Items agency option set to Off, you can change the 

order in which items are positioned in the project items list. The project items list is displayed on the Items tab 

of the Project Category and Item Summary component. 

• Note: If your agency uses the option to set proposal item line numbers to match project item line 

numbers (Set Proposal Item Line Number Equal to Project Item Line Number), this feature is not 

available after the project enters the addenda workflow phase. 

Follow these steps to renumber the items in a project: 

1. Click the Projects link on the Preconstruction component. 

2. On the Project Overview component, locate the project for which you want to renumber items. 

3. From the Actions menu on the project row, select Items: Renumber. 

 

The system takes you to the Renumber Project Items component with all of the project items listed in line 

number order. 

4. Click in the Line Num field for the item you want to reposition, and type a number representing the 

position in the list where you want to move the item. 

5. Click the Save button. 

Example 

Your project has five items numbered 10, 20, 30, 40, and 50. The item numbered 50 needs to be moved so that 

it appears between the existing line numbers 10 and 20. To accomplish this, you would perform these steps: 

1. Click in the Line Number field for Line 50. 

2. Delete the number 50, and type the number 15 (or any number between 11 and 19). 

3. Click the Save button. 
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Support 

We will continue to refine these instructions. Please send your input to Ken Sereduk 
 
If you have any questions please ask your group’s Super-user first. If they are not available or don’t have an answer 
please contact Ken Sereduk.  


